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Napredni saveti za tipografiju
• Dva glavna tipa alata: Horizontalna Tip Alat i Vertikalni Tip Alat

• Dva osnovna režima tipa: Tip tačke (klik) i Površina / Tip paragrafa (kliknite i 

prevucite)

• Pristup tipskim opcijama preko menija Tipe, nudeći više mogućnosti 

manipulacije tekstom

• Uobičajeni paneli uključuju: Character Panel, Paragraf panel i Glyphs Panel za 

fina podešavanja

• Orijentacija teksta se može prebacivati između horizontalnih i vertikalnih 

formata

• Pretvaranje teksta u putanju koristeći Create Vork Path; Korisno za dizajn 

tokova posla

• Pretvori u oblik: pretvaranje teksta u vektorske oblike koji se mogu uređivati sa 

sidrištima



Adobe Fonts & Font Management
• Adobe Fonts (ranije Typekit) nudi veliku biblioteku fontova; dostupno preko 

pretplate na Creative Cloud

• Fontovi su grupisani u porodice sa različitim stilovima (bold, kurziv, 

kondenzovan)

• Pregled uzorka teksta preko fontova i podešavanje veličine pregleda i unosa

• Korišćenje filtera za sortiranje po jeziku, stilske oznake (kaligrafske, čiste) i 

korišćenje promenljivih fontova

• Promenljivi fontovi podržavaju dinamičko podešavanje svojstava kao što su 

težina i širina

• Dodavanje fontova izborom Dodaj porodične ili pojedinačne stilove sa sajta 

Adobe Fonts

• Licenciranje obično podržava i ličnu i komercijalnu upotrebu Adobe Fontova

• Adobe Fonts interfejs sadrži informacije o dizajnerima fontova i pravima 



Klasifikacija i filtriranje fontova
• Fontovi su kategorisani u tipove: Serif, Sans Serif, Slab Serif, Script i

Handwritten

• Filtriranje fontova na osnovu tipova porodice fontova unutar Adobe Fonts ili 

lokalno instaliranih fontova

• Porodice fontova uključuju više varijacija; filtriranje po broju dostupnih stilova 

(KSNUMKS + stilovi)

• Dodatne opcije filtriranja uključuju širinu, visinu, kontrast i kurziv

• Pretraživanje fontova po imenu; Ne mogu se naći svi fontovi u Adobe Fontovima

• Slični predlozi za fontove mogu se pojaviti kada tačno podudaranje nije 

dostupno

• Kada se font doda, on postaje odmah dostupan za upotrebu u Photoshopu



Avanced Font Features & Glyph Panel
• Filtriranje fontova po klasama, uključujući Monospace, Serif, Sans Serif, itd

• Označavanje fontova kao favorita, čineći ih lako filtrirati kroz ikonu zvezde

• Primena filtera za prikazivanje samo Adobe Fontova ili fontova sa sličnim 

stilovima

• Funkcija Slični fontovi preporučuje alternative vizuelno blizu izabranog fonta

• Panel Gliphs prikazuje alternativne dizajne znakova unutar porodice fontova

• Neki fontovi nude glifove na latiničnom, grčkom i drugim jezicima, 

poboljšavajući tipografsku svestranost

• Dodavanje glifova dvostrukim klikom i umetničkim modifikovanjem pojedinačnih 

likova

• Izbegavanje preterane upotrebe glifova za čitljivost i estetsku ravnotežu



Identifikovanje fontova iz slika
• Photoshop nudi alate za identifikaciju fontova iz slika koristeći Match Font i 

Adobe Fonts

• Počevši od otvaranja slike iz foldera projekta

• Pristup Match Font funkciju preko menija Tip za automatsko otkrivanje fonta

• Izbor do tri reda teksta za analizu; jednostavniji fontovi daju bolje podudaranje

• Photoshop predlaže sistem i Adobe fontove sa vizuelnim pregledima za 

poređenje

• Rasterizovani ili spljošteni slojevi teksta i dalje mogu biti analizirani za 

detekciju fonta

• Adobe Fontovi omogućavaju otpremanje slike, odabir tekstualne linije i direktno 

aktiviranje odgovarajućih fontova

• Tačnost prepoznavanja fonta zavisi od jasnoće slike, jednostavnosti teksta i 

pravilnog izbora



Korišćenje stilova za poboljšanje toka posla
• Stilovi: unapred napravljeni efekti sloja; brzo se primenjuje na tekst, oblike ili 

slojeve slika

• Pristupanje panelu Stilovi preko menija Prozor > Stilovi

• Stilovi uključuju kombinacije efekata kao što su Bevel & Emboss, Stroke, Drop 

Shadov i Patterns

• Kategorije uključuju tkaninu, krzno, neutralno i osnove

• Kreiranje prilagođenog stila konfigurisanjem efekata sloja u Laier Stile Panel i 

čuvanje preko novog stila

• Dodavanje prilagođenih stilova u biblioteku, grupisanje u fascikle, ponovna 

upotreba preko projekata

• Uvoz i izvoz stilova kako bi se omogućilo deljenje ili prodaju jedinstvenih 

dizajna

• Korišćenje stilova pomaže u pojednostavljenju radnih tokova dizajna i 



Kreiranje prilagođenih četkica
• Kreiranje novog, 6k6 inča, 300-ppi dokument za demonstraciju

• Četke u Photoshopu su zasnovane na osvetljenosti: crna otkriva, bela skriva

• Suprotno ponašanje u odnosu na maske slojeva, gde bela otkriva i crna skriva

• Crtanje željenih oblika pomoću alata Brush sa 100% tvrdoćom u crnoj boji

• Crtanje više oblika četkica na platnu (tačke, linije, potezi)

• Korišćenje pravougaonog Markuee Tool za odabir oblika

• Čuvanje selekcije kao prilagođene četke preko Edit > Define Brush Preset

• Pregled preokreće crno-belu sliku, pretvarajući crne oblike u tragove četkice



Korišćenje i poboljšanje prilagođenih četkica
• Odabir prilagođene četke sa panela Brushes i slikanje na novom sloju

• Korišćenje postavki četke za podešavanje ponašanja: Dinamika oblika, 

rasipanje, itd.

• Veličina Jitter menja veličinu četke po potezu; Ugao podrhtavanje varira 

orijentaciju

• Zaobljenost podrhtavanje uvodi oblik izobličenja za varijacije

• Rasipanje širi tragove četke

• Broj podešava gustinu

• Prenos kontroliše neprozirnost varijabilnost po potezu

• Zaključavanje transparentnih piksela i rasterizaciju sloj oblika za slikanje u 

njemu

• Izvoz četkica preko izvoza odabranih četkica za ponovnu upotrebu



Uvod u Puppet Varp Tool
• Puppet Varp omogućava precizne distorzije slike pomoću mrežastog 

preklapanja

• Izolovanje subjekta iz pozadine pomoću alata za izbor objekata

• Dupliranje predmetnog sloja i postavljanje iznad prilagođene pozadine

• Pretvaranje predmetnog sloja u Smart Object za nedestruktivno uređivanje

• Pristup Puppet Varp preko Edit > Puppet Varp

• Igle dodat na ključnim tačkama (zglobova) za kontrolu kretanja

• Kretanje se odvija povlačenjem igle, stvarajući realnu ili preteranu deformaciju

• Režimi: Normalno (podrazumevano), Kruta (ograničena fleksibilnost), Distorzija

(preterano savijanje)



Dodavanje dodatnih četkica iz Adobe
• Adobe obezbeđuje besplatne, profesionalne četke sa aktivnom pretplatom na 

Creative Cloud

• Pristup putem: Panel četkica > ikona hamburgera > dobiti više četkica

• Preusmeravanje na Adobe-ov veb sajt sa setovima četkica Kajla Vebstera

• Kajl Vebster četke: industrijski standard, koriste veliki studiji kao što je Disnei

• Ranije plaćeno, sada besplatno kao deo Adobe-ove akvizicije i integracije

• Kategorije četkica uključuju ugalj, poluton, prskanje i još mnogo toga

• Preuzimanje željenih paketa četkica direktno sa Adobe sajta

• Instaliranje četkica i uvoz u Photoshop preko  opcije Import Brushes



Testiranje dodatnih četkica iz Adobe
• Kreiranje novog dokumenta (11×8 inča, 300ppi) za testiranje četkica

• Korišćenje četkica za ugalj za realno crtanje i senčenje; podešavanje protoka

za kontrolu

• Polutonske četke pružaju gotove tonske obrasce; idealno za stripove i 

stilizovane efekte

• Prskanje četke simuliraju mastilo ili sprejeve boje; korisno za dinamične 

teksture

• Neki paketi četkica (kao polutonovi) su veliki i mogu usporiti performanse

• Četke su specifične za nišu (crtež, tekstura, tonski efekti)

• Korišćenje modova mešanja, podešavanja boja i podešavanja protoka za 

poboljšanje izlaza

• Teške četke se mogu ukloniti kako bi se optimizirale performanse (ako se ne 

koriste)



Uvod u Perspective Varp Tool
• Perspektiva Varp Alat omogućava usklađivanje objekata sa postojećim 

perspektivama scene

• Uvoz slika za demonstraciju (kutija za papir i pozadina puta) i pretvaranje 

objekata u pametne objekte za nedestruktivno uređivanje

• Navigacija za uređivanje > perspektive Varp da biste aktivirali interfejs alata

• Alat se sastoji od dva glavna režima: Laiout (L taster) i Varp (V ključ)

• Kreiranje mreže klikom i prevlačenjem ugaonih tačaka da odgovara ivice 

objekta

• Mreže mogu snap zajedno poravnavanjem strane; plave linije ukazuju na 

snapping tačke

• Prebacivanje na Varp režim da podesite perspektivu povlačenjem ugao ručke

• Držite Shift i kliknite da ograničite ivice na prave linije (označeno žutom bojom)



Primena perspektivnog iskrivljenja i dodatnih izmena
• Manipulacija u realnom vremenu za bolju integraciju objekata unutar scene

• Nakon savijanja, perspektiva se može fino podesiti pomeranjem pojedinačnih 

tačaka

• Demonstriranje izmena pomoću slike staklene zgrade sa dvostranim 

podešavanjem mreže

• Obezbeđivanje paralelnog poravnanja linija kako bi se poboljšao realizam u 

transformaciji

• Završna prilagođavanja uključuju pomeranje tačaka za željeni vizuelni efekat

• Opciono čišćenje neba pomoću Clone Stamp Tool: uzorkovanje sa Alt (opcija) i 

slikanje pogođenih područja

• Pre i posle poređenja koja pokazuju značajan uticaj ovog alata

• Perspektiva Varp podržava i kreativnu manipulaciju i realistično 

kompozitiranje



Uvod u tok posla Vanishing Point
• Otvaranje dve slike: složena perspektivna slika i ilustracija slika

• Izbegavanje korišćenja Perspective Varp Tool zbog složenosti; koristeći 

Vanishing Point Filter umesto

• Otključavanje pozadinskog sloja pre primene filtera Vanishing Point

• Pristup filteru preko filtera > Vanishing Point za pokretanje poseban interfejs

• Korišćenje alata za kreiranje ravnine da biste definisali mrežu osnovne 

perspektive na slici

• Pažljivo podešavanje ravni poravnanje dok smernice ne postanu plave, što 

ukazuje na važeću geometriju

• Zumiranje za preciznost; korišćenje alata Edit Plane za prečišćavanje

• Prozor Vanishing Point uključuje alate kao što su šator, pečat, četka, kapaljka, 

zum i pan



Transformisanje slika u perspektivi
• Kreiranje dodatnih aviona klikom i prevlačenjem iz postojećih da se izgradi 

punu geometriju

• Pritiskom na OK da urežete podešavanje perspektive nakon što su definisani svi 

avioni

• Izbor ilustracije sliku pomoću Ctrl / Command + Kliknite na sličicu, a zatim 

kopiranje sa Ctrl / Command + C

• Kreiranje novog sloja i ponovno otvaranje filtera Vanishing Point

• Lepljenje slike ilustracije unutar prozora Vanishing Point

• Korišćenje alata Transform za promenu veličine, rotiranje i pozicioniranje slike 

u definisane ravni

• Dupliranje slike pomoću Alt / Option + Drag da postavite više instanci unutar 

scene

• Podešavanje plasmana za realizam i urezivanje izmena pritiskom na OK



Mešanje i maskiranje sa grunge teksturom
• Grupisanje dupliranih ilustraцionih slika i blago smanjenje neprozirnosti za 

mešanje harmonije

• Uvoz i otključavanje grunge sliku; kopiranje nakon izbora sličicu

• Kreiranje novog sloja, ulazak Vanishing Point Filter, i lepljenje grunge

• Koristeći Transform Tool ponovo za usklađivanje i skaliranje grunge u perspektivi

• Izvršavanje i kopiranje grunge sloja; lepljenje u masku sloja ilustracije pomoću 

Ctrl / Cmd + Shift + V

• Invertovanje maske sa Ctrl / Cmd + I da otkrije ključne detalje ilustracije i 

meša teksturu

• Korišćenje četkica za prečišćavanje ivica i postizanje organskih efekata mešanja

• Procena rezultata sa prekidačima vidljivosti sloja



Uvod u 3D u Photoshopu
• 3D je bio glavna karakteristika u Photoshopu; Adobe je počeo da ga postepeno 

ukida 2022. godine

• Nedavne verzije Photoshopa više ne uključuju 3D; starije verzije potrebne za 

pristup

• Funkcionalnost zavisi od kompatibilnog grafičkog hardvera; nepodržani sistemi 

ne mogu da pokažu 3D čak iu starijim verzijama

• 3D u Photoshopu se odnosi na objekte sa dužinom, širinom i visinom - dodajući 

jačinu zvuka izvan 2D

• Radni prostor se menja prilikom ulaska u 3D okruženje; Predloženo vraćanje na 

Essentials radni prostor (nakon završetka)

• Kreiranje KSNUMKSD iz teksta koristeći nekoliko metoda: Tip meni, KSNUMKSD 

meni, ili KSNUMKSD panel

• Nakon nanošenja 3D na tekstualni sloj, dubina se vidljivo dodaje, a 



Navigacija i manipulacija 3D slojevima
• 3D radni prostor uključuje alate za kretanje, rotiranje, klizanje i skaliranje 3D 

objekata

• KSNUMKSD slojevi panel prikazuje komponente kao što su scena, životna 

sredina, prikaz kamere, beskonačna svetlost i sloj objekata

• Svaki objekat i izvor svetlosti može se pojedinačno manipulisati pomoću alata za 

3D transformaciju

• Uređivanje mreže, materijala i svojstava osvetljenja kroz panel Svojstva

• Uređivanje slojeva materijala pojedinačno (prednji, bočni) za vizuelno 

prilagođavanje

• Filtriranje okruženja i osvetljenja; podešavanje ih

• Desni klik opcije na sceni ili objektu da otkrijete mrežu i podešavanja 

materijala

• Razumevanje ovih komponenti je od suštinskog značaja za potpunu kontrolu nad 



Kreiranje KSNUMKSD objekata iz prilagođenih oblika
• Photoshop omogućava korisnicima da kreiraju 3D slojeve iz prilagođenih 

slojeva oblika

• Korišćenje slojeva panela za crtanje, promenu veličine i podešavanje boja 

prilagođenog oblika

• Pretvaranje oblika u 3D objekat preko 3D > Nova 3D ekstruzija iz izabranog 

sloja

• Panel Properties kontroliše dubinu istiskivanja i druga podešavanja KSNUMKSD

• Izbor iz unapred podešenih stilova ekstruzije da varira izgled oblika je

• Rotacija Alat omogućava 360 stepeni gledanje 3D objekta

• Složeni oblici poput vaze za cveće mogu se modelirati iz jednostavnih 2D oblika



Kreiranje KSNUMKSD objekata iz prilagođenih oblika
• Mesh preseta (kocka, konus, krofna, šešir, itd) za kreiranje 3D iz slojeva

• Izbor KSNUMKSD > Nova mreža iz sloja za obmotavanje tekstura slika na 

KSNUMKSD objekte

• Unapred podešena postavka Cube Wrap primenjuje teksturu na sve strane, za 

razliku od standardne kocke  

• Razglednica unapred podešena stvara ravne 3D površine bez dubine

• Photoshop podržava podrazumevane 3D modele kao što su limenke sode, boce 

vina i piramide

• Izvoz kreiranih 3D slojeva u formatima kao što su OBJ, STL i Collada za spoljnu 

upotrebu

• Uvoz eksternih 3D modela (OBJ datoteke iz Maia ili 3ds Mak)



Poboljšanje realizma -svetlost, senke i rendering
• Svojstva materijala kao što su metalik, hrapavost i neprozirnost utiču na 

realizam 

• Podešavanje IBL (Image-Based Light) da odgovara pozadinskom osvetljenju i 

refleksije

• Kontrolisanje senki kroz beskonačnu svetlost i repozicioniranje pomoću alata 

Move + Shift

• Povećanje mekoće senke za prirodniji izgled

• Klikom na Render da biste pokrenuli obračun osvetljenja, materijala i senki

• Kvalitet rendering zavisi od performansi sistema i složenosti scene

• Resetovanje i obrezivanje kompozicije slike kako bi odgovarala perspektivi 

scene

• Precizno poravnanje senke je potpomognuto funkcijom Premesti na prikaz



Finaliziranje postavljanja KSNUMKSD objekata i 

svojstava mreže• 3D objekti se mogu rotirati, promeniti veličinu i pozicionirati na osnovu željenog 

vizuelnog rezultata

• Rendering konačnu kompoziciju da potvrdi da li je objekat pravilno superponira

• Superponiranje podrazumeva integraciju 3D objekta u postojeću 2D sliku

• Prebacivanje senki: bacaju senke se odnose na one projektovane na površinama

• Unapred podešeni oblik omogućavaju brze izmene kao što su inflacija ili dubina 

istiskivanja

• Svojstva mreže takođe omogućavaju uvijanje, sužavanje i deformaciju oblika

• Podešavanja kosine (širina, ugao) poboljšavaju detalje površine i realizam

• Resetovanje transformacija da se vrati na podrazumevane parametre objekta



Osvetljenje, okruženje i podešavanja scene u 3D
• Tipovi svetlosti uključuju beskonačnu svetlost (kao što je sunčeva svetlost), 

reflektor i tačkasto svetlo

• Svojstva svetlosti omogućavaju podešavanje mekoće senke i orijentaciju koja 

odgovara pogledu

• Postavke okruženja uključuju ambijentalnu boju i osvetljenje zasnovano na 

slici (IBL)

• Poboljšanje realizma životne sredine sa kontrolama senke, refleksije i 

uzemljenja

• Optimizacije scene kao što je granična kutija kako bi se smanjilo opterećenje 

performansi na složenim projektima

• Režimi gledanja uključuju žičani okvir, normale i linijske ilustracije za bolju 

kontrolu objekata

• Podešavanje koordinata za mrežu, svetla, okruženje i ukupnu scenu



Vežba 1
• Otvorite pozadinsku sliku i promenite veličinu na širinu KSNUMKS inča da biste 

smanjili veličinu datoteke

• Kreirajte novi sloj i primenite 3D > Novu mrežu iz sloja > Mesh Preset > Wine 

Bottle

• Idite na panel KSNUMKSD slojeva za upravljanje komponentama boca, etiketa 

i poklopca

• Podesite položaj boce u sceni pomoću KSNUMKSD Slide Tool i skalirajte na 

odgovarajući način

• Modifikujte materijal poklopca: tamno crvena baza / unutrašnjost, 0% 

hrapavost, 13% metalik

• Nanesite unapred podešenu staklenu glatku na bocu; podesite osnovnu / 

unutrašnju boju na magenta nijanse, neprozirnost na KSNUMKS%

• Izmeni teksturu etikete: ubacite PNG oznaku, dodajte pozadinu i dizajn zlatne 



Vežba 1
• Ažurirajte okruženje scene kopiranjem pozadine kao IBL (Image-Based Light) 

teksture

• Smanjite intenzitet svetlosti okoline na 60%; podesite beskonačnu svetlost sa 

30% mekoće senke i 90% intenziteta

• Test render scenu da biste pregledali materijale i refleksije

• Poboljšajte poklopac boce: povećajte metalik na 23% i potamnite boju za 

realizam

• Izvršite kvalitetan konačni render koristeći JPEG, maksimalni kvalitet, retrace 

final, i prag 5

• Uvezite prikazanu sliku za konačne izmene preko Camera Rav Filtera

• Poboljšajte jasnoću, teksturu, smanjite koncentraciju senke i podesite kontrast 

/ živost

• Sačuvajte izmenjenu sliku; Sačuvaj fajl projekta za buduća prilagođavanja



Kreiranje gradijenta KSNUMKSD pomoću alata za 

četkicu za mikser• Uspostavljanje novog dokumenta (16k11 u, 150 ppi) za demonstraciju

• Korišćenje alata Ellipse za crtanje oblika sa različitim gradijentnim 

popunjavanjem

• Dupliranje elipse više puta da bi se stvorila raznolikost

• Primena različitih gradijenata na svaku dupliranu elipsu

• Rasterizovanje svih slojeva oblika kako bi se omogućilo slikarstvo 

funkcionalnost

• Spajanje rasterizovanih elipse u jedan sloj

• Priprema za korišćenje alata za četkicu za mikser na ovom jedinstvenom sloju

• Obezbeđivanje uzorka Svi slojevi je isključen pre uzorkovanja



Podešavanja četkice za mikser i tehnike slikanja
• Aktiviranje alata za četkicu za mikser sa sledećim podešavanjima:

- Opterećenje: 100%, Protok: 100%, Ravnanje: podesivo (5-24%)

• Izbor unapred podešenog kao što je Dri Heavi Load za početak

• Alt-klikom da biste uzorkovali gradijente iz sloja spojenog oblika (Option na 

Mac-u)

• Korišćenje tableta za crtanje za više prirodnih poteza i kontrole

• Kreiranje novog sloja za poteze četkom da ostanu nedestruktivni

• Eksperimentisanje sa pisanjem i oblicima da posmatra pseudo-3D efekat

• Isprobavanje različitih preseta (Vet Heavi Mik) za različite rezultate

• Podešavanje veličine četke i izglađivanje za umetničku fleksibilnost



Vežba 2
• Idi na File > Otvori i izaberite PSD sliku žene koja pleše

• Predmet je već isečen iz pozadine u datoteci

• Pritisnite Ctrl / Cmd + J da duplirate predmetni sloj

• Izaberite Mixer Brush Tool i povećajte veličinu četke na oko 370 pk

• Držite Alt i kliknite na odeću da biste uzorkovali boje (žuta, narandžasta, 

plava)

• Podesite režim četke na suvo, teško opterećenje i kreirajte novi sloj za 

slikanje

• Počnite slikati šarene poteze oko predmeta kako biste formirali apstraktni 

dizajn

• Slikajte iza predmeta, a zatim kreirajte nove slojeve za poteze ispred



Vežba 2
• Koristite Laso Tool da izoluje ruku i donji deo tela za odvajanje slojeva

• Pomerite slojeve tako da se čini da potezi prolaze iza i ispred delova tela

• Napravite novi sloj iznad sloja poteza, klip ga na poteze (Alt + klik)

• Dodajte senke gde se elementi preklapaju kako biste povećali realizam i 

koherentnost

• Koristite crnu četku na isečenom sloju da suptilno obojite senke

• Nanesite masku sloja da omekša oštre ivice i uklonite neželjene linije

• Podesite neprozirnost i mešanje režima za realno mešanje senki

• Ponovite za sve ključne tačke preklapanja: interakciju ruku, telo i glavu sa 

efektom

• Konačni rezultat je vizuelno integrisana 3D kompozicija postignuta korišćenjem 

miksera četkom i senkama



Uvod u video montažu u Photoshopu
• Photoshop podržava osnovnu video montažu i animaciju

• Uvoz video zapisa preko File > Otvori ili drag-and-drop, pojavljuje na Timeline 

Panel

• Timeline Panel omogućava kontrolu okvir-po-frame i osnovnu video 

manipulaciju

• Video slojevi grupisani pod panelom Slojevi kao Video grupa, omogućavajući 

organizaciju i vidljivost prekidača

• Primena uobičajenih alata kao što je Crop na video zapise, baš kao i kod slika

• Karakteristike vremenske linije uključuju:

- Zoom klizač za precizno uređivanje

- Kontrole reprodukcije i informacije o brzini kadrova (25 fps)

• Video snimci su napravljeni od okvira; 25 fps = 25 slika u sekundi



Tehnike uređivanja i poboljšanja
• Korišćenje ikone makaze za rezanje video klipova u određenim tačkama

• Brisanje neželjenih delova da skratite snimak

• Dodavanje audio (MP3) na vremenskoj liniji za pozadinsku muziku

• Zvuk se može smanjiti, podesiti jačinu zvuka i uključiti efekte fade-in / out

• Desni klik na video za opcije kao što su:

- Prilagođavanje brzine i trajanja

- Usporeno ili brzo napred

• Dodavanje prelaza (Fade sa belim / crnim) između klipova ili na početku / 

kraju

• Prelazi su klik-drag elementi čije trajanje može da se prilagodi

• Reprodukcija može zaostajati u početku zbog renderinga; Jednom keširan, igra 

glatko



Više funkcija za uređivanje i tekstualne animacije
• Photoshop video montaža ima ograničenja u odnosu na Premiere Pro 

• Opcije rezolucije reprodukcije: 50% ili 100% 

• Uvoz video / audio fajlova (MP4, MP3) direktno u vremenskoj liniji za 

uređivanje

• Dodavanje i pozicioniranje tekstualnih slojeva preko video zapisa je 

jednostavno; Tekst se može promeniti i poravnati

• Primena stilova slojeva na tekst za vizuelna poboljšanja

• Ikona štoperice omogućava animaciju ključnih kadrova za svojstva kao što su 

transformacija i neprozirnost

• Ključni kadrovi definišu početno i krajnje stanje za animacije (povećanje skale 

ili bledenje neprozirnosti)

• Photoshop podržava jednostavnu animaciju neprozirnosti sa ključnim 

kadrovima za bledenje teksta u / out



Prilagođavanje boja, izvoz i radni tok Saveti
• Slojevi za podešavanje kao što su Vibrance i Color Lookup poboljšanje video 

boja bez uticaja na druge slojeve

• Mešanje režima podešavanje kako podešavanja boja interakciju sa video 

slojevima

• Primena dodatnih Photoshop podešavanja (nivoi, krive), ali može usporiti 

performanse zbog veličine video datoteke

• Slojevi teksta, oblika i prilagođavanja mogu se grupisati i organizovati

• Izvoz video preko ikone izvoz; izbor H.264 format (MP4) za kompatibilnost i 

kvalitet

• Izbor unapred podešenih opcija kvaliteta; visok kvalitet preporučuje se za 

konačni izlaz

• Vreme renderinga varira u zavisnosti od složenosti i sistemskih resursa

• Eksperimentisanje sa četkama, efektima i animacijama za kreativno uređivanje 



Vežba 3
• Otvorite fasciklu projekta i prikažite sve formate datoteka radi lakšeg izbora

• Izaberite sliku planine, sliku neba i sliku letećeg objekta

• Uvezite slike neba i letećih objekata kao pametne objekte kako biste očuvali 

kvalitet tokom transformacija

• Postavite sloj neba ispod planine i prilagodite ga na odgovarajući način kako bi 

odgovarao platnu

• Podesite osvetljenost neba pomoću podešavanja krive da biste vizuelno 

poboljšali pozadinu

• Promenite veličinu platna na 1920k1920 piksela za upravljivu veličinu 

animacije

• Omogućite Timeline panel i kreirajte novu video vremensku liniju za rad 

animacije

• Organizujte slojeve pravilno i sakrijte neiskorišćene slojeve radi jasnoće tokom 



Vežba 3
• Animirajte planinski sloj skaliranjem i pomeranjem da biste stvorili dubinu; 

Podesite ključne kadrove za transformaciju

• Animirajte sloj neba suptilnim kretanjem pri sporijoj brzini kako biste 

simulirali daleki pomak pozadine

• Animirajte sloj letećeg objekta: skala, rotirajte i pomerite ga da simulira 

lebdenje iza planine

• Podesite tajming ključnih kadrova za glatke prelaze i realne varijacije brzine 

između slojeva

• Pregledajte animaciju kako bi se omogućilo pravilno prikazivanje i glatku 

reprodukciju

• Pomerite sloj letećeg objekta ispod planinskog sloja da biste postigli 

odgovarajući efekat

• Sačuvajte projekat kao PSD datoteku za buduće uređivanje i backup
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